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1 Introduction

Thank you!

Scope

Congratulations on your purchase of the Ovation Media Server & Sequencer.
Ovation is a ground-breaking Media Server and Sequencer with the tools you need to produce and run shows in
many spheres of activity. For example:

Theatres

Theme Parks
Museums

TV Game Shows
Trade Shows

AV Presentations
Radio stations
Retail Outlets
Film Festivals

are just a few of the possible applications for Ovation.
Note: IMPORTANT! - The first thing you need to do is register your software to acquire
your Ovation key(s) and to be included in our user support list.

http://www.merging.com/register/

Please also subscribe to the User Forum at:

http://www.forum.merging.com

This document is intended to get you up and running with Ovation and as quickly as possible. For more detailed
information about Ovation, Pyramix and VCube please see the PDF User Guides which are installed with the soft-
ware.

Important! If you are installing an upgrade to Ovation please read: For Users Per-
forming Upgrades on page 11 first.

If you have purchased Ovation as an integrated (Turnkey) system, the installation information in this guide will be
redundant, since these systems come with all hardware and software pre-installed. If you are configuring your
own system, please refer to the following instructions.
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Windows 10 - IMPORTANT!

Note: Merging strongly recommends you defer feature updates in Windows 10.
Windows 10 users should never update to Beta Windows versions or install major new
updates before making sure they are supported by Merging. Please refer to our Win-
dows 10 Configuration Guide:

https://confluence.merging.com/display/PUBLICDOC/Windows+10+Configuration

Details about the recommended Windows 10 Defer Update setting
https://confluence.merging.com/display/PUBLICDOC/Windows+10+Defer+Updates

Windows 10 Recommended Version for MassCore

Ovation v9.0 is supported under the following Windows 10 updates:
October 2020 update (20H2) is supported with Pyramix 25th HotFix 3 & RTX64 3.7.4
May 2020 Update (2004) is supported with Pyramix 25th HotFix 3 & RTX64 3.7.4
November 2019 Update (1909) supported with Pyramix 25th Anniversary & RTX64 3.7

May 2019 Update (1903) is supported as of Pyramix v12.0.5 HotFix as well as the Meltdown and Spec-
tre Windows updates Windows 10 Zombieload update is supported with MassCore/RTX64 3.6.2 and

3.7.0
. October Update (1809)
. Spring Creator (1803)
. Fall Creator (1709)
. Creator (1703)
. Anniversary (1607)
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Windows Updates
Users wishing to apply Windows updates may refer to the Merging list of validated Compatible Windows updates:

https://confluence.merging.com/pages/viewpage.action?pageld=25755762
Important! Before you perform a Windows 10 update on a system already running a MassCore version it will be

important for users to remove MassCore from the MT Security MassCore tab prior to performing a system
update.

Updating from Windows 7 to Windows 10
Users performing an update from Windows 7 to Windows 10 should proceed in this way:

https://confluence.merging.com/display/PUBLICDOC/Updating+Windows+7+to+Windows+10+for+MassCore

Note: Users wanting to update Windows 10 to another version must follow the proce-
dures documented here:
https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide

Note: Once the update to the required Windows version has been completed follow this
Ovation v9 and MassCore installation Guide.

For Ovation v9 Native users

Ovation Native users may use the Windows 10 Anniversary (1607) update, Creator update (1703), Fall Creator
(1709), Spring Creator (1803), October Update (1809), May 2019 Update (1903), November 2019 Update
(1909), May 2020 Update (2004), October 2020 update (20H2).
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2 Ovation Versions - Compatibility and Installation Steps

Native (ASIO on 3rd party hardware):

Compatibility: Windows 7 Professional 64-bit and Windows 10 Professional 64-bit
Installation Steps:

Ovation Software Installation, See: Ovation Software Installation on page 18
Entering Authorization Keys, See: Ovation Software Registration on page 20

. Select ASIO and the correct card/device in the VS3 Control Panel (Start Menu > Control Panel > VS3 Control
Panel)

Native with ASIO/WDM for RAVENNA and Horus / Hapi / Anubis:

Compatibility: Windows 7 Professional 64-bit and Windows 10 Professional 64-bit
Installation Steps:

. Install the Merging Audio Device (MAD) provided with your Horus / Hapi / Anubis or available from:

https://www.merging.com/support/downloads

. Select ASIO and the correct card/device in the VS3 Control Panel (Start Menu > Control Panel > VS3 Control Panel)
. Entering Authorization Keys See: Ovation Software Registration on page 20

. Select the desired network adapter in Merging RAVENNA ASIO Panel (Start Menu > All Programs > Merging Tech-
nologies > Merging Audio Device (or 3rd party ASIO Driver))will open its panel. Please see details in the Merging
Audio Device (MAD) online documentation:

https://confluence.merging.com/pages/viewpage.action?pageld=70221956

. Select ASIO/RAVENNA in the VS3 Control Panel (Start Menu > Control Panel > VS3 Control Panel). See: Configure
RAVENNA in the VS3 Control Panel on page 30.

Note: Please download and install the latest ANEMAN application in order to manage
and monitor your AolP devices from:

Mykerinos only:

Not supported from version 6.x. Last compatible version is
Ovation v4.1 32-bit installer.

MassCore with Mykerinos:

Not supported from version 6.x. Last compatible version is
Ovation v5.1 32-bit installer.
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MassCore with RAVENNA and Horus / Hapi / Anubis:
Compatibility: Windows 7 Professional 64-bit and Windows 10 Professional 64-bit.

Note: Merging strongly recommends users to perform a Windows Update prior to installing Ovation v9.

N e PR

&

10.
11.
12.
13.

14.

15.

16.

Installation Steps:

. NET-MSC-GBEXT1 Installation See: Installing the Merging Technologies NET-MSC-GBEX1 PCle Ethernet Controller
Card on page 28

Ovation Software Installation, Ovation Software Installation on page 18
. Entering Authorization Keys, See: Ovation Software Registration on page 20
. MassCore Installation, See: MassCore Installation on page 23
Select MassCore with RAVENNA in the VS3 Control Panel (Start Menu > Control Panel > VS3 Control Panel)

Quick Setup Checklist For Systems with Horus / Hapi / Anubis

Shut down the system and install the MassCore NET-MSC-GBEX1 PCle Ethernet controller card. (Card drivers are
included in the Pyramix and Ovation installers.)

Existing users of 64 bit MassCore must uninstall the previous MassCore version from the MT Security application.
MassCore users MUST configure their BIOs settings. Please see: BIOS Settings on page 15

Disable Windows Firewall in Windows Control Panel Security.

Install Google Chrome.

Install Ovation v9.x (This will also install Pyramix 25th Anniversary)

Enter your new MassCore (RTX64 - 3.0 key in MT Security Settings then import your 25th Anniversary/v9 keys in MT
Security Settings.

On a fresh install also in MT Security Settings install MassCore from the MassCore Tab.

MassCore SMP users (recommended for i7 CPU configurations and above) should launch the VS3 Control Panel and
assign 2 cores to MassCore. (A reboot will be required.)

In the VS3 Control Panel ensure that RAVENNA is selected in the Hardware section.
Configure the Switch/Router (if present) Please refer to the RAVENNA Network Guide.
Launch Ovation.

You can also launch the MTDiscovery application and double-click on the Horus / Hapi entry for browser remote
access.

Ensure that the Horus / Hapi / Anubis is set to the same sampling rate as Pyramix or Ovation. A warning prompt will
appear if this is not the case.

We recommend Horus, Hapi and Anubis users update to the latest firmware available. Obtainable here:

https://www.merging.com/products/interfaces/downloads

Configure I/0 as required in Pyramix/Ovation and Horus / Hapi / Anubis. Please download and install the latest ANE-
MAN application in order to manage and monitor your AolP devices from:

www.aneman.net/#download.
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3 For Users Performing Upgrades

Note: Ovation v9 keys are required to run Ovation. Users running MassCore will need a
new Mass-Core version (RTX64 - 3.7).

Ovation
We recommend uninstalling any previous version of Ovation and Pyramix before installing Ovation v9.

From the Windows Control Panel select Programs and features.
Remove the installed version of Ovation and Pyramix.

Note: Merging recommends installing v9 BEFORE uninstalling the previous version of
MassCore. UNLESS you are planning to update your Windows 10 version and already
have a MassCore version installed, then you must follow the update procedure in the
documents linked to below. N.B In this case the previous version of MassCore MUST be
uninstalled BEFORE uninstalling the previous version of Pyramix/Ovation:

https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide

Note: IntervalZero version should read: IntervalZero RTX64 3.7 version 3.7.4.5222

Masscore

MassCore users running Interval Zero RTX64 version prior to v3.7.0.4983 MUST remove the existing MassCore run-
time.

Once Ovation v9 is installed follow these steps:
1. Launch MT Security Settings and select the MassCore Tab.

2. Choose the Uninstall MassCore RunTime option and reboot. (There will be one reboot.)

Note: RTX DONGLE USERS (SSK-HUD-RTX). The SSK-HUD-RTX dongle is no longer
required as of Pyramix 25th HotFix 3.

3. The previous Masscore RTX64 will now uninstall:

jﬁl Update 4 for IntervalZerc RTXE4 3.7 Runtime - InstallShield Wi... — >

Uninstalling IntervalZero RTXG64 3.7 Runtime

The program features you selected are being uninstalled.

Please wait while the Installshield Wizard uninstalls IntervalZero RTXG4 3.7
Runtime. This may take several minutes.

Status:

ack Mext = Cancel

IntervalZero Uninstall dialog
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4. Once the uninstallation is finished, there is no need to reboot. Launch MT Security Settings and enter your
v9 keys or confirm their presence.

Warning! If when entering your new MassCore key you experience a failure message,
please contact:

keys@merging.com

and let us know your Dongle serial number so that Merging can identify your current MassCore/RTX64 key and
renew it if necessary.

Note: Users installing MassCore may see a popup dialog un-authorized license message.
Please ignore until reboot.

RTX64 validation is not available.
RTXe4d license validation is not

available. Please contact support.

Rixbd System Tray

RTX64 validation is not available dialog

5. Select the MassCore Tab and choose the Install MassCore RunTime option.

Keys  MTActiveKey MassCore Apout

-"’& MassCore Unlimited
@ MassCore RunTime not installed on this computer; Please install it.

Install MassCaore RunTime

Activation

Seral Mumbd IntervalZero RTXESL 3.7 Runtime

RTx64 Key E’ Iji Please wait while Windows configures IntervalZero RTXE4 3.7

§ Rurtime

Time remaining: 23 seconds

QK Cancel

MT Security Settings - MassCore tab
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6. An RTX64 Driver approval dialog may appear. Accept it, click on OK to close the MT Security Settings panel
and reboot the system.

Note: Please note that the installation process can take some time.
7. Afterinstallation you should see an Interval Zero entry in Windows Control Panel > Programs and Fea-
tures. This should read: Interval Zero RTX64 3.7 Runtime (Version 3.7.4.5222).

8. Launch the VS3 Control Panel and configure it for MassCore - RAVENNA See: Configure RAVENNA in the
VS3 Control Panel on page 30
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4 System Requirements

Wintel platforms tend to increase in number of cores, speed and performance at a tremendous rate. New and
faster processors are released almost on a monthly basis. Therefore we have not included suggested Motherboard
or Processor specifications here.

We maintain a list of up to date PC configurations in the Support Section of our website at:
http://www.merging.com/pages/pcconfig

WARNING: Since Pyramix v12 - Ovation v8, Intel Core Processors prior to 4th Generation
(4XXX) are no longer supported.

Please refer to our system recommendation for more details:

https://confluence.merging.com/pages/viewpage.action?pageld=24608853

Other Components

. Graphics Card: As of Pyramix 12, Ovation 8 and VCube 8, Merging strongly recommends using a dedi-
cated graphic card rather than onboard graphics. Most particularly when the following are required

. Multiple display outputs,

. OpenGL Ul plugins (Flux, Izotope, ....)

. Working with video, or when your workflow places high demands on graphics.
Please refer to the Pyramix PC Specifications for all details:

http://www.merging.com/pages/pcconfig
https://confluence.merging.com/display/PUBLICDOC/Graphic+cards+recommendations

Sufficient HD space and speed for your audio media files. The speed and amount of disk space required
depends on sample rate, word length, number of tracks and length of program material.

A typical 7200 RPM SATA drive is sufficient for 48 tracks at 48 kHz. Higher track-counts and/or higher sam-
pling rates will require an SSD drive and/or multiple drives configured in Raid 0, 1, 10 or 5

We recommend disks should be formatted as NTFS volumes with 64kB block sectors for audio. For video
128kB block sectors are desirable.

BD/DVD/CD-ROM combo drive or better

Multiple 19" or larger monitors highly recommended.
Minimum resolution 1280x1024

3 button mouse
Ovation MassCore Systems

Certified Operating Systems

. 0S: We recommend and certify Ovation Version 9.x and later under Windows 7 Professional 64-bit
and Windows 10 Professional 64-bit.

Ovation Native

Certified Operating Systems

. 0S: We recommend and certify Ovation Version 9.x under Windows 7 Professional 64-bit and Win-
dows 10 Professional 64-bit.
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5 PC Setup

Motherboard Drivers and Utilities

Motherboard drivers should be updated to current versions.
Motherboard Utilities should NOT be installed.
Please refer to our Windows configurations guide for more details:

https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide

BIOS Settings

Recommended BIOS Settings
Boot Device Control

We recommend that the UEFI boot should be disabled and set to:
Boot Device Control: Legacy only

Hyperthreading

Intel® Hyperthreading Technology is supported on 64 bit MassCore systems. This setting is commonly found in
Main Bios page, or under CPU configuration. (see the motherboard manual for further details).

. MassCore SMP users: Merging Recommends that Hyperthreading is enabled to benefit fully from the real-
time engine power, VS3 support and the MassCore multithreaded engine.

. MassCore Non-SMP users: Will gain some of these benefits by not enabling Hyperthreading, so that a full
single Core is dedicated to MassCore

. For further information refer to the Pyramix User Manual chapter MassCore & VST Core Allocation

. Pyramix Native: We recommend that Hypertreading is enabled.

The following features can create MassCore overloads (blinking red MSC).

Intel® Speedstep Technology (also known as Enhanced Intel® SpeedStep), as well as CPU C State (or Intel® C-State)
features must be disabled in the BIOS.

Some Recent Intel boards have a global setting to disable those features known as Intel® Dynamic Power Technol-
ogy. If present this should be turned off. These settings are commonly found in BIOS Power options or CPU Con-
figuration.

Overclocking is not supported.

Configuration Guides
Windows 10 users should refer to the Merging Windows 10 Configuration Guide:

https://confluence.merging.com/display/PUBLICDOC/Windows+10+Configuration

Merging has a number of specific PC-configuration guides which are available on request. Tell us your system con-
figuration modeled on our recommendations at:

http://www.merging.com/support/pc-config

so that we can send you the latest configuration guide. Please contact:

support@merging.com
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Display Settings
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MEDIA SERVER & SEQUENCER

Ovation requires a minimum display resolution of 1280x1024 in 256 colors which MUST be set to small fonts

mode.

A Merging Windows configuration guide is available here with recommendations.

https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide

Windows Control Panel > System > Advanced System Settings opens the System Properties window. Select
the Advanced tab > Performance Settings to open the Performance Options window. Choose the Visual

Effects Tab:

Windows 7
Onboard Graphics (Intel)
@ Custom;;
| Animate controls and elements inside windows
Animate windows when minimizing and maximizing
Animations in the taskbar and Start Menu
Enable Aero Peek
Enable decktop composition
Enable transparent glass
Fade or shde menus into view
Fade or shde ToolTips into view
| Fade out menu items after didking
Save taskbar thumbnail previews
J | Show shadows under mouse poiniber
| Show shadows under windows
Show thumbnails instead of icons
Show translucent selection rectangle
Show window contents while dragging
Shide open combo boxes
Smooth edges of screen fonts
Smiaoth-seroll st boxes
Lise drop shadows for icon labels on the desktop
Use visual styles on windows and buttons

S | |

Windows 10

=
™ Custom:

Dedicated Graphic Card

@) Custom:!

<

O E e (<

Anamate controls and elements insde windows
Aramate windows when minimizing and maximizing
Animations in the taskbar and Start Menu
Enable Aero Pesk

Enable desktop composition

Enable transparent glass

Fade or slide menus into view

Fade or slide ToolTips into view

Fade out menu items after didkdng

Save taskbar thumbnail previews

Show shadows under mouse pointer

Show shadows under windows

Show thumbnails instead of icons

Show franslucent selection rectangle

Show window contents while dragging

Slide open combo boxes

Smooth edges of soreen fonlks

Smoath-scroll kst baxes

Use drop shadows for icon labels on the desktop
Use visual styles om windows and buttons

[] Animate controls and elements inside windows
[] Animate windows when minimizing and maximizing
[] Animations in the taskbar

[ Enable Peek

[[] Fade or shide menus into view

[] Fade or shide TeolTips into view

Fade out menu items after clicking

[] save taskbar thurmbnail previews

Show shadows under mouse pointer

[ Show shadews under windows

[] Show thumbnails instead of icons

] Show translucent selection rectangle

[ Show window contents while dragging

0

[+] Smocth edges of screen fonts

[+] Smoocth-scroll list boxes

Use drop shadows for icon labels on the desktop
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Disable the following settings by unticking the boxes to prevent MassCore peaks:
Animate Windows when minimizing and maximizing - disable
Animations in the taskbar and Start Menu - disable
Aero Peek - disable
Enable desktop composition - disable (Windows 7 Only)
Enable transparent glass - disable
Fade or slide menus into view - disable
Fade or slide ToolTips into view - disable
Save taskbar thumbnail previews - disable
Show translucent selection rectangle - disable
Show window content while dragging - disable

Slide open Combo boxes - disable

Power Management

N.B. As with other Digital Audio Workstations and Non-Linear Editors, we recommend setting the PC to the High
Performance or RTX64-Recommended (MassCore Users) Power management schemes.

MassCore is NOT designed to support Standby modes.

Aero graphics

Disable AERO themes for maximum performance. (Windows 7 Only.)

Indexing

In the interests of better performance we recommend turning Indexing OFF for all Data drives in the system.

Other Applications

Like all real-time applications, Ovation works best when there are no other unnecessary applications or services
running.

Ovation Keyboard

Note: ADR/Ovation keyboard users must update the keyboard driver if running on Win-
dows 10 October update (1809) or above. Please refer to the following page for installa-
tion information:

https://confluence.merging.com/display/PUBLICDOC/Pyramix+ADR+and+Ovation+keyboard+install+guide
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6 Ovation Software Installation

Important! If you have not already done so, before installing the Merging Technologies
software for the first time OR as an update please run Windows Update and accept any
updates marked as Important. Note that this can take a considerable time. (Over an
hour in some cases.) This is a Microsoft problem.

Note: You must have full Administrator Access to install Ovation.

Installation Overview:

Note: If you have purchased hardware options such as the NET-MSC-GBEX1 PCle Ether-
net card, the Sync Board and or a Black Magic or AJA video card, please install these fol-
lowing the instructions in the accompanying documentation. The drivers for all of these
except BlackMagic cards, Ovation Keyboard and Sealevel GPIOs are installed automati-
cally with the Ovation software.

Note: The Sealevel GPIO's are no longer installed with the Pyramix software. Please refer
to the page here for installations:

https://confluence.merging.com/pages/viewpage.action?pageld=15139174

Note: Where applicable Blackmagic video card drivers have to be downloaded from the
Blackmagic website and installed separately. Merging has certified its applications under
Blackmagic Design versions 10.x, 11.4 and 11.5. Please download and install from:

https://www.blackmagicdesign.com/support

Installer

The Ovation software uses an automated installer wizard which will install all necessary prerequisites. Installing
Ovation will also install Pyramix.

Custom Install

If you choose the Custom option you may exclude installation of any of the individual components in the wizard,
if the device in question is not present on your machine or if you do not intend to use an item, by un-ticking the
tick boxes next to the items listed in the wizard.

Note: The security dongle must be in place and the security keys entered before
attempting to launch the software.

Flux VS3/V3 plug-ins

Download the Flux Center application in order to install the Flux VS3 plugins:

https://www.fluxhome.com/download

More details here:

https://confluence.merging.com/display/PUBLICDOC/Flux+Download+Center
Ensure you have valid Merging Flux v3 Keys in order to run these Flux VS3 plug-ins.
VB VS3 plug-ins

VB VS3 plug-ins have a stand-alone installer. Download and run the VB Plug-in - VS3 installer after installing Ova-
tion. Run the installer and reboot the system.

https://confluence.merging.com/display/PUBLICDOC/VB+Plugins+%28VS3%29+standalone+installer
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7 Running the Installer

Note: If you have a SafeNet dongle please remove this before installing Pyramix and
replace it after installation is complete.

Note: The HASP dongle is not supported on 64-bit systems. If you have a HASP dongle
please contact your Merging Technologies Sales Partner to purchase a SafeNet dongle
and transfer your keys.

Once the NET-MSC-GBEX1 Ethernet card has been properly installed, you can now install the Ovation 7.x software.

To install the Ovation 9.x software insert the USB memory stick. The installation program will auto-start on a PC
where auto-start is configured on. Otherwise, double-click on the USB memory stick icon.

Please follow the automatic installation procedure accepting the option to install unsigned drivers and re-boot
your PC once setup is complete.

Note: For Windows 7 Users Only: The installer checks and verifies if the Windows
updates KB3033929 and KB3123479 are present on the system and if not installed
already (from running Windows Update manually or automatically) they will be installed
for Windows 7. If the updates are required, please be patient. The update can take as
long as one hour. This delay is caused by Microsoft. An extra re-boot is required once the
updates are installed.

N.B. If the Windows Update Service is disabled, Windows cannot install any updates,
one consequence will be that the MassCore NIC will not work. To check if the Service is
running open the Windows Control Panel, go to Administrative Tools > Services and
ensure that the Windows Update service is started and therefore running. If the Service
is stopped it can be started manually by selecting it and choosing Start in the Action
menu or from the right-click context menu.

Note: This update is already embedded in Windows 10.

Note: For Windows 7 Users: If the installation appears to freeze for a long period please
check that the Driver Signing warning dialogue is not hidden behind another Window.
Installation will not continue until you click OK in this dialog.

WARNING: Certain computers do not shut down properly despite the reboot command
issued by the installer but only perform a log off. In this case, please activate a full shut
down manually.
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8 Ovation Software Registration

The Ovation software and its various software options are protected by an authorization key mechanism which
uses a unique registration key number generated by Merging Technologies. Based on purchased software compo-
nents, this key is unique to your security dongle, your Company Name and your User name. Once you have regis-
tered your software you will be provided with this Key or Keys (depending on the chosen options).

If you did not receive this key, have lost it or would like to change the user and/or company name, please contact
your Merging Sales Partner with your SafeNet dongle serial #, your User Name, your Company Name and the list of
purchased software components. Usually, a key can be issued within one business day, after the verification of
your personal data has been completed.

Entering your Key(s)

After the Ovation installation process you will be prompted to enter your Authorization Key. If you click Yes the
MT Security Settings dialog will be launched automatically, allowing the Key or Keys to be entered immediately.
If you choose not to enter your Key at this point you can do so later by choosing one of the following procedures:

1. Double-click the file YourPersonalKeyXXXXX.mtk. This is attached to the email containing your Key(s).

2. Open the MT Security Settings Control Panel
(Windows Task Bar Start > Control Panel > MT Security Settings),
click the Import Key button and browse for your Key file named:

YourPersonalKeyXXXXX.mtk

3. Open the MT Security Settings Control Panel (as above), in the Registration section select the dongle num-
ber corresponding to the SafeNet Key, click the Enter Key button and type your User Name, Company Name
and Key then click OK. Repeat this step for each Keys listed in the email.

Changing or re-entering a Key
Should you need to subsequently change or re-enter a Key, follow the appropriate option above.

QLM Cloud based security

For users needing to run Pyramix, Ovation or VCube without a Merging SafeNet dongle cloud based security is
available.

Note: SafeNet keys cannot be transferred to QLM security for a chosen release. This pro-
cess can only be undertaken at the upgrade stage.

For further information about cloud security please see the following online documentation:

Cloud Licenses activation/deactivation

https://confluence.merging.com/pages/viewpage.action?pageld=65437899

QLM SelfHelp Tool
https://confluence.merging.com/pages/viewpage.action?pageld=65437985

MTSecurity troubleshooting
https://confluence.merging.com/pages/viewpage.action?pageld=65437961

Evaluation Mode

If started without a valid registration key, the software will recognize that no valid key is available and will startin
“evaluation” mode, which only allows for basic operation of the software as follows:

. Limited to 2 channels of I/0 on host soundcard
. No Project > Save function

. Tone is added to new recordings

. All optional extra cost features are deactivated

All editing functions, playback, file type conversions etc. are fully functional. Only one Cue List can be opened.
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Ovation

MEDIA SERVER & SEQUENCER

Keys
At any time you can check the serial number of your Security dongle and the software options enabled in your sys-
tem in the MTSecurity application.

Dongle Licensing Tab

2 Merging Technologies Security Settings ®
Fregistration
»/ | Safelet Key v
= [ Inchuda Hays sored on Safablen Dongles in MT Saesty
Seral Mumber |5m_ |
User Name |Ficarde Ryan |
Company Hame |I'»'¢n;ir-;- Technelogies |
Hays
Imperd Keyls) | Oiptiorms Wabddy A
Pyramix Core Permanent
Enter Key High Samplng Frequency Pemanent
Parans Her Surround Mang Pemanent
| el T . D
Remove Al Keys Machine Cortrol Support Pemanent
e InterChange - Final Cut Pro XML Pemanent
i Remobe Cortrol Suppad Pemuarient
Pyramix Hative Audio Enabled Pemanent
Update User Extended Hative Audo Suppon Pemanent
Native Auda Suppod Pemanent
Limzed Native Audio Support Pemanent
CL:R Suppon Pemanent
DDP Support Pemanent
SACDVDSD Supped Pemanent
Surrounsd Medng BExtended Pemansnt
Natsve Vides Suppest Pemarient
Cue Sheet Printer Pemanent
InterChange - Akal DD-5eties Pemansnt
Interchangs - OMF Pamanent W
€ b3
Cancel

MT Security Settings - Dongle Licensing tab
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Ovation

MEDIA SERVER & SEQUENCER

Cloud Licensing Tab
X Merging Technalogies Security Settings *
Dongle Licensing  Clowd Lcensing  MassCore Licensing  About
Activation
Product PyramiOvation \Wube ~
Activation Key | |
Licenze Status [Pdi'-'miqn i3 requinad ]
Features

Product Verson | 22th Anniversary r

Option Validty ~

Pyrami Core Mat active

High Samping Frequency Mot active

Surmound oarg Mot active

Timelode Suppent ot active

Machine Control Support ot active

InterChange « Final Cut Pro XML Mot active

Remote Control Support Mot active

Pyrames Nztive Audio Enabled Mt actove

Extended Mative Audio Suppest Mt active

Mative Audis Suppod Mat active

Limied Mative Audio Support ot active

CD-R Support Mt active

DDP Support Mot active

SACD/DSD Suppent Mat actove

Surmound Moing Extended Mt active

Mative Video Support ot active

Cue Sheet Printer Mat active

InterChange - Akal DD-Series Mot active

Interchange - OMF Mot active -

DS P . . :

Cancel

MT Security Settings - Cloud Licensing tab
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9 MassCore Installation

@ MassCore
System Requirements

A quad core Intel processor is the minimum requirement.

Conditions
. You MUST be logged in as an Administrator to install MassCore

Note: You do not need to be logged in as an Administrator to RUN Ovation with Mass-
Core™, just to install it.

You must have a NET-MSC-GBEX1-Ethernet card in your system.

You must have a MassCore 48 (Base) Key in order to proceed with the installation. You must also have a
MassCore 64bit (Base) key and an RTX 64 key. Please contact your Merging Technologies Sales Partner if
you do not have these options but want to use MassCore.

MassCore Installation
1. Install v9.x Ovation.exe.

2. Launch MT Security Settings and select the MassCore Tab.

3. Reboot selecting the NON-MassCore Windows Boot line. If you experience any problems please refer to the
troubleshooting document here:

https://confluence.merging.com/display/PUBLICDOC/MassCore+Uninstall+Troubleshooting

4. The previous Masscore RTX64 will now uninstall:

jﬁ' Update 4 for IntervalZero RTXE4 3.7 Runtime - InstallShield Wi... — >

Uninstalling IntervalZero RTXG64 3.7 Runtime

The program features you selected are being uninstalled.

Please wait while the InstallShield Wizard uninstalls IntervalZero RTXG4 3.7
Runtime. This may take several minutes.

Status:

ack Mext = Cancel _

IntervalZero Uninstall dialog

5. Once the uninstallation is finished, there is no need to reboot. Launch MT Security Settings and enter your
v9 keys or confirm their presence.
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Warning! If when entering your new MassCore key you experience a failure message,
please contact:

keys@merging.com

and let us know your Dongle serial number so that Merging can identify your current MassCore/RTX64 key and
renew it if necessary.

Note: Users installing MassCore may see a popup dialog un-authorized license message.
Please ignore until reboot.

RTX64 validation is not available.
XE ralidation is not

RTX64 validation is not available dialog

6. Enter Your Key(s) in MT Security Panel (Make sure you have a valid MassCore key.) The MassCore 64bit and
RTX64 keys are required for 64-bit systems.)

In the MT Security Panel select the MassCore Tab

8. Press the Install MassCore Run Time button (will only be enabled if the MassCore base, MassCore 64bit
keys and a valid RTX64 license code are present..
Please note that the installation process can take some time to proceed.

i - ™
g;f Merging Technologies Security Settings [i_E-J

Keys | MTActiveKey | MassCore | About

& MassCore Unlimited
[

@ MassCore RunTime not installed on this computer; Please install it.

[ Install MassCaore RunTime

VS3 merging Technologies Security Settings dialog
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9. A Windows Security RTX Driver approval dialog will appear:

-+~ | Windows Security @
Would you like to install this device software?

Mame; IntervalZero, Inc, RTX64 Drivers
Publisher: IntervalZero, Inc.

Always trust software from "IntervalZero, Inc.". Install | : Don't Install {

! You should only install driver software frem publishers you trust. How can [ decide
which device software is safe to install?

VS3 Merging Technologies Virtual Studios Settings dialog

10. Click Install. The installation progress window will appear:

IntervalZero RTXG4 3.7 Runtime

[d] Please wait while Windows configures IntervalZero RTX64 3.7
Runtime

Time remaining: 3 seconds

RTX64 Install Progress dialog
11. When the install completes, click on OKin the Merging Technologies Security Settings dialog to close it.
12. Restart System after the install.

Note: Please note that the installation process can take some time. After installation you
should see an Interval Zero entry in Windows Control Panel > All Control Panel Items
> Programs and Features.This should read: IntervalZero RTX64 3.7 Runtime (Version
3.7.4.5222).
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Launch the VS3 Control Panel:

Merging Technologies Virtual Studio Settings ‘ [&J

/'“ Application | Owvation - |

Flatform | MassCore - |

Cores Allozation [zhared by all applications- requires admin rightz]

YWindows B D 2  MazzCore [Dedicated)

Latency

@ Low latency [5.33ms (22 43, 95, 192, 384kKHz)
SESET [4ms (3348, 96, 192, 384kHz)
Eutra low latency [2.66ms (= 48, 96, 192, 384kHz]

Ilbra lowe latency [1.33ms (@ 43, 96, 192, 384KHz]

Hardware
On Bus Yideo/TC b onitor Jack

J—% A @

Ravenna

Audio Bridge
Digable Murnber of Channels [1/O]; | 16

@ ASI0 Device Mode [to create a wirtual ASID Device in the system)

Secondary Audio Device Host Mode
[to connect to an existing Audio Device in the system az a secondary [ /0]

Fiewire Mixer Mode [to create a Bewire Miser in the system]

[ K ] [ Apply ] | Cancel

- -

VS3 Merging Technologies Virtual Studios Settings dialog

13. In the Platform section select MassCore

14. We recommend the use of Low latency or AES67 modes by default. Ultra low latency & Extra low latency are
available for Horus / Hapi / Anubis users with Ovation v9.x recommended configurations.

http://www.merging.com/pages/pcconfig

We also recommend that users working in DXD and DSD use Low Latency.

Installation Guide v9.0 : MassCore Installation

MERGING §

AUDIO FOR THE NETWORKING AGE



64 Bit MassCore Notes

. Double licence protection, both MassCore 64bit and RTX64 keys are required BEFORE MassCore installa-
tion. The MassCore 64 bit installation can be performed only if these two keys are present.

. The RTX64 Activation key licence is authorized by an online tool on Interval Zero's site after the Merging
software (MassCore) installation is complete.

. Note that the RTX64 MassCore licence can only be installed ONCE per Windows installation, since it is
locked to the system.

. At present if there is a requirement use MassCore Pyramix on two different computers regularly, it will be
necessary to purchase a second MassCore 64bit Base key. Note that a solution exists for those who would
like to have their MassCore/RTX64bit keys stored on a dongle (Hasp/IntervalZero), instead of having them
linked to a unique system. This allows users to move their MassCore/RTX64 licensing to different systems
by carrying two dongles (Merging-SafeNet & IntervalZero-HASP). THis solution requires the purchase of an
additional dongle. Please contact your local Merging Technologies sales office if you require this
option.(Reference: SSK-HUD-RTX).

Re-licencing MassCore 64 bit RTX

If a systems needs to be re-licenced for example after a Windows OS re-installation process or if it is necessary to
move the licence to another system, then you should contact us at:

keys@merging.com
Please give the reason for your system migration or re-installation since the RTX64 key is not meant to be renewed
frequently.

If Merging cannot follow up with a timely response (in emergency or at weekends) please contact the Interval
Zero (RTX) sales team.
Please ensure that you have the RTX64 Authorization Key number (IZRTX64-030-XXXX-XXXX...) when doing so.

Interval Zero Support team:

sales@intervalzero.com

Note: This does not apply to new systems running RTX64 3.7.4 and higher.
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Certified Operating Systems (OS) for RAVENNA

Ovation Version 9.x MassCore in RAVENNA mode is certified under Windows 7 Professional (64-bit versions) and
Windows 10 Professional (64-bit versions).

System Requirements
We maintain a list of up to date PC configurations in the Support Section of our website at:

http://www.merging.com/pages/pcconfig

Please refer to the MassCore-RAVENNA recommendations (Quad-Core is the minimum requirement)

Required Hardware
The Merging Technologies NET-MSC-GBEX1 PCle Ethernet controller card is required for MassCore - RAVENNA.

Installing the Merging Technologies NET-MSC-GBEX1 PCle Ethernet Controller Card
The NET-MSC-GBEX1 PCle card should be installed in your computer before installing Ovation v9.x.

The NET-MSC-GB EX1 card

Procedure

1. Power down your PC and switch it off at the wall. Remove the screws securing the top or side of the case and
carefully slide off the panel.

2. Ananti-static wristband is sensible precaution whenever working with sensitive electrical equipment. Keep-
ing one hand on a metal part of the case will have the same effect, though you may need both hands when
installing certain items of hardware.

3. Locate an empty PCle slot and remove the metal backing plate by removing the screw holding it in place and
carefully sliding it up and out. In some cases, there are no backing plates and you will need to remove a length
of metal instead. Do this using a flat-blade screwdriver and/or pliers, taking care to avoid any sharp edges left
behind.
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4. Remove the NET-MSC-GBEX1 card from its protective anti-static envelope and align it with the vacant PCle
slot as shown below.

2 Anti- Su rge

(TR

~=as By
DIH'U'E HO00E32AD) g
m I|| FXARD-IGN- 1IN Eil\.ill_'n:l.‘lLl\-‘l"

Installing the NET-MSC-GB EX1 card

5. Push down, gently at first, ensuring you have the pins aligned correctly with the slot, and then apply more
pressure to slot the card fully home.

6. Use the screw which was used to retain the backing plate to secure the card in place and check that the card
sits comfortably.

7. Finally, replace the case cover(s) and switch the machine back on at the socket.
8. At the next power up and boot Windows will discover the Merging Ethernet PCle card.

Ovation v9.x can now be installed.

Required Software

In order to operate Ovation with RAVENNA and Horus / Hapi / Anubis, Ovation v8.x or later must be installed. The
Ovation v9.x installer includes Apple bonjour. As of Ovation v7.0.7 HotFix the installer no longer includes the
ANEMAN application which now comes as a separate installer. Please download and install the latest ANEMAN in
order to manage and monitor your AolP devices from:

www.aneman.net/#download

Note: Driver signing. Please tick Always trust “Merging Technologies” when the first
warning message about unsigned drivers appears.

Enter your Ovation keys

Launch MTSecurity settings and enter your Ovation 9.x keys. Please see Entering your Key(s) on page 20.
Note: v9 keys are required and MassCore requires an RTX64 key in order to run RTX64
3.7.

Install MassCore
Please see: MassCore Installation on page 23

Note: A valid MassCore (Base) key and a valid MassCore 64-bit key are mandatory.

The MassCore key is held on the SafeNet dongle. Please make sure that you are in pos-
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session of a dongle and valid keys in order to operate Ovation in MassCore-RAVENNA
mode.

Note: The NET-MSC-GBEX1 Ethernet card requires MassCore in order to function.

Configure RAVENNA in the VS3 Control Panel

| - Application | Pyramix Virtual Studio |
Platform | MassCaore - |
|
Cores Allozation [zhared by all applications]
Windows 3 1 1  MazzCore [Dedicated]
Latency

@ Low latency [5.33ms (& 48, 96, 192, 384K Hz]
Estra low latency [2.66ms (& 48, 96, 192, 384K Hz]
Ilkra lows latency [1.33me (2@ 43, 96, 192, 384KHz]

Hardware
On Buz Wideo/TC Manitor Jack

J_%‘é [ &

Ravenns

Audio Bridge
@ Dizable

AS10 Mumber of Channels [1/0]: 16
R ewire

Ok | | Apply | | Cancel |“

VS 3 Merging Technologies Virtual Studios Control Panel
Launch the VS3 Control Panel

—
.

Cores Allocation Leave on the default setting for now.

For now, leave Latency on the default setting Low Latency
Select Platform : MassCore

Select Hardware : On Bus as RAVENNA (box ticked)
Audio Bridge : Set as required.

Click on the OK button.

When the VS3 panel Do you want to save routing? dialog box appears, click on OK

W ® N o Un 2 WwWN

the VS3 control panel will close.

Before First Launch
Before launching Ovation v9.x, you must ensure that a PTP Master* is present on your RAVENNA network. Merg-
ing Technologies recommends using its Horus, Hapi or Anubis converters as PTP Master.

* The Precision Time Protocol (PTP) is a protocol used to synchronize clocks throughout a computer network.
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Note: RAVENNA mode supports all three Latency modes. (VS3 Control Panel)
To enable RAVENNA I/0O connections please refer to the separate ANEMAN User Manual.

Note: Merging Technologies highly recommend Low Latency or AES67modes for opti-
mal performance. The Extra and Ultra latency modes should only be used on Merging
Turnkey systems or approved configurations since these modes can be very demandin-
gon performance, depending on system configuration and user workflow.

Note: Horus / Hapi / Anubis users should refer to their respective User Manual for config-
uration set-up with Ovation.

Note: At the first Ovation launch if your system is not configured correctly you might see
the message below:

Your system is not configured according to Merging’s recommendations.

Note: Some Windows updates could harm your system, we strongly advise you to Defer
Windows updates.
More details on the procedure to follow are available here:

https://confluence.merging.com/display/PUBLICDOC/Windows+10+Defer+Updates
Troubleshooting

RAVENNA: Horus / Hapi / Anubis & Network configuration

Merging recommend that the Ethernet MassCore card and Horus / Hapi / Anubis are configured to obtain an IP
address automatically.

Setting Horus / Hapi / Anubis and Network Card to Obtain IP Addresses Automatically
Network Card

1. Open Network Connections in the Windows Control Panel

2. Right-click on the MassCore Ethernet card NET-MSC-GBEX1 and open Properties.

3. Select Internet Protocol Version 4, TPC/IPv4 (which is the only one activated) and click on Properties.
4. Select the Obtain an IP address automatically option.

5. Click on OKin each dialog to accept the changes and close the dialogs.

Horus / Hapi

1. Open the Horus / Hapi Setup >Advanced > Network page

2. IntheIP address section select Auto

Setting Fixed IP addresses
Note: For users running firmware prior to 3.9.3b38957, setting a Fixed IP is not recom-
mended due to the fact that the Horus / Hapi Maintenance mode will be only be effec-
tive in Auto IP mode. This is mandatory for Firmware updates.

Note: Anubis

Open the Anubis Settings > General page and browse to the Network section.
On the Obtain an IP address option, select Auto.

1. First, check the IP address of the Horus / Hapi device under Setup > Network
To be able to see each other, the Merging Technologies Network card and Horus / Hapi must be in the same
range of addresses. (for example 192.168.xxX.xx).
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2, The Horus /Hapi/ Anubis IP address can be checked (and changed if required in the Horus / Hapi Setup >
Network) and Anubis Settings > General > Network section.

3. The IP address of the MT Network card can be changed in Windows Control Panel > Change Adapter Set-
tings

4. Right click on the Merging Technologies NIC and select Properties.
Select Internet Protocol Version 4, TPC/IPv4 (which is the only one activated) and click on Properties.

6. Switch to Use the following IP address and enter an IP address that is in the same range as the Horus / Hapi /
Anubis IP address. The Subnet Mask should be added automatically.

7. Click on OKin each dialog to accept the changes and close the dialogs.

Windows Firewall and UAC
Recommendation

If not configured correctly, Windows Firewall can block communication between MassCore and Horus / Hapi /
Anubis. User Account Control should also be set to Never Notify.

Firewall

Open the Windows Control Panel. Open the System and Security section and under Windows Firewall
disable the Firewall for the Public Network.

. Go back to the Windows Control Panel and click on Windows Firewall. Click on Change notification
settings. Ensure Block all incoming connections, including those in the list of allowed programs is
NOT ticked.

User Account Control

Open the Windows Control Panel. Open the User Accounts section and under Change User Account
Control Settings move the slider down to Never Notify.

Antivirus
Recommendation

. Merging also recommends that any Antivirus software is properly configured so as to not interfere with
the DAW. See this page for further details:

https://confluence.merging.com/display/PUBLICDOC/Antivirus+and+Merging+Technologies+Softwares
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11 Native - ASIO/WDM

Note: Windows October 2020 update (20H2) and May 2020 Update (2009) are sup-
ported with Pyramix 25th HotFix 3 & Ovation 9.0.6 HotFix 3, Windows10 November
2019 Update (1909) is supported as of Pyramix Native 25th Anniversary and above
only. Previous Pyramix versions will NOT run under the November 2019 Update
(1909).

Install Ovation and the drivers for your ASIO/WDM device.
Configure ASIO in the VS3 Control Panel

Merging Technologies Virtual Studio Settings ‘ &J \
B Application | Qvation |
Platform  |§iative - ASIO -
1/0 Selection
Drriver narne: |.-'-‘-.SIEI Fireface USE A
Infia

SampleFlate: 44100
[nputs; 18

Cutputs: 18
B uffer size 256

Toprnozt priarity

Audio Bridge
Dizable Murnber of Channels [1/0]; | 16

@ ASI0 Device Mode [ho create a wirtual ASI0 Device in the systemn]

Secondary Audio Device Host Mode
[to connect to an existing Audio Device in the system az a secondary /0]

Rewire Miker Mode [to create a Rewire Miser in the system]

K | [ Apply ] | Cancel

-

VS3 Merging Technologies Virtual Studios Control Panel

1. Launch the VS3 Control Panel (Start: All Programs > Merging Technologies > VS3 Runtime > VS3 Control
Panel

Select Platform : Native - ASIO

Select 1/0 Selection ; Driver name : Select your ASIO device from the drop-down list
Audio Bridge : Set as required.

Click on the OK button.

When the VS3 panel Do you want to save routing? dialog box appears, click on OK

N o »n s W N

The VS3 control panel will close.
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The Inputs and Outputs present on the ASIO device will now be available in Pyramix.

Merging Audio Device

As of Ovation v9 and above Merging recommends that you install the new Merging Audio Device (MAD) if you are
working with ASIO and/or WDM. The MAD replaces the previous RAVENNA ASIO Driver.

For more information please refer to the Merging Audio Device Online Documentation:

https://confluence.merging.com/pages/viewpage.action?pageld=70221956

12 First launch

Important! After installation has been completed, please reboot the PC before
attempting to launch Ovation. Then open the VS3 control panel application.

Start > All Programs > Merging Technologies > VS3 Runtime > VS3 control panel

For Systems with MassCore RAVENNA
Please see: Configure RAVENNA in the VS3 Control Panel on page 30

For Native Systems
Please see: Configure ASIO in the VS3 Control Panel on page 33

Launch Ovation

Double-click on the Ovation desktop icon to launch Ovation.

Please see important information on next page!

Note: At the first launch a firewall approval dialog may appear:

g Windows Security Alert @

@ Windows Firewall has blocked some features of this program

Windows Firewall has blocked some features of Pyramix Virtual Studio Application on all public
and private networks,

@ Hame: N | .
Publisher: Merging Technologies 5. A.

Fath: C:'program filesimerging technologies\pyramix virtual
studio\pyramix. exe

Allow Pyramix Virtual Studio Application to communicate on these networks:

| Private networks, such as my home ar work netwark

Public networks, such as those in airports and coffee shops (not recommended
because these networks often have lite or no security)

What are the risks of allowing & program through a firewall?

Allow access | | Cancel

Windows Security Alert dialog -Windows Firewall

Click on_Allow access since this is necessary to ensure correct Audio Connections and VT2 (Virtual Transport
2) functioning.
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Note: For further information about options available in the VS3 Control Panel, please
see the Pyramix User Manual.

Note: At first Ovation launch and or after installing MassCore the following alert box
may appear. If it does please reboot the computer one more time:

8 MassCore RunTime is not properly configured; configuration updated. Please reboot the computer.
1 |

VS3 error alert box

Note: If after a computer restart this error message still appears, please follow the
instructions in our knowledge base:

https://confluence.merging.com/display/PUBLICDOC/MassCore+Runtime-+is+not+properly+configured+error+message
For further assistance please contact:

support@merging.com

Note: At the first Ovation launch if your system is not configured correctly you might see
the message below:

Your system is not configured according to Merging’s recommendations.

Note: Some Windows updates could harm your system, we strongly advise you to Defer
Windows updates.
More details on the procedure to follow are available here:

https://confluence.merging.com/display/PUBLICDOC/Windows+10+Defer+Updates

Documentation

The Ovation and Pyramix User Manuals and Quick Start Guide are available from within the
application and may be accessed via the Help menu or by pressing F1, or online at:

http://www.merging.com/downloads
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13 Troubleshooting

Please visit regularly:

www.merging.com
And for the latest Troubleshooting Guide and FAQ sections:

https://confluence.merging.com/

14 Lost or Stolen Merging Technologies Security Keys

(Sentinel USB Dongles)

The Merging USB Key carries all the value of your Merging software and the software licence authorization to use
it. Please ensure you do not lose the USB key as Merging Technologies cannot be held responsible if this is lost or
stolen.

If your USB key is lost or stolen then please make a claim on your insurance in the usual way just as you would for
any other item you own. Merging will be happy to confirm the details and value of the software licence and USB
key to your insurance company. If your USB key is lost or stolen and a different user should attempt to register for
this key, Merging will notify you and the authorities in your country that an attempt has been made to register this
stolen item.

If your USB key should become defective or is broken, please ensure this key is returned to merging after request-
ing and RMA (Return Merchandise Authorization.) Only after the receipt of this key in the Merging Offices will it be
determined if it may be exchanged under warranty free-of-charge, or if the damage is outside the warranty scope.
in which case only a modest fee to replace it with a new key will be charged (and not the entire value of the soft-
ware.)
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15 Contacting Merging

International Office:
Merging Technologies S.A.
Le Verney 4
CH-1070 Puidoux
Switzerland
Phone: +41 21 946 0444

UK:
Merging UK (Emerging Ltd.)
23 Campbell Court
Campbell Road
Bramley
Hampshire
RG26 5EG
UK
Phone: +44 (0) 118 402 5090
Fax: +44 (0) 870 123 1747

Email: sales@merginguk.com

USA:
Merging USA (Independent Audio)
43 Deerfield Road
Portland,
ME 04101-1805
United States of America
Phone: +1(207) 773 2424
Fax: +1(207) 773 2422

For all documentation inquiries or suggestions for improvement:
http://www.merging.com
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